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1 Disclaimer of liability

The information contained in these instructions corresponds to the technical status at the
time of printing of it and is passed on with the best of our knowledge. The information in
these instructions is in no event a basis for warranty claims or contractual agreements
concerning the described products, and may especially not be deemed as warranty
concerning the quality and durability pursuant to Sec. 443 German Civil Code. We reserve
the right to make any alterations or improvements to these instructions without prior
notice. The actual design of products may deviate from the information contained in the
instructions if technical alterations and product improvements so require. It may not, in
part or in its entirety, be reproduced, copied, or transferred into electronic media.

Softing Industrial Automation GmbH
Richard-Reitzner-Allee 6
85540 Haar / Germany

Tel: + 49 89 4 56 56-0
Fax: + 49 89 4 56 56-488

Internet: http://industrial.softing.com
Email: info.automation@softing.com
Support: support.automation@softing.com

softinG)

© Copyright 2014 Softing Industrial Automation GmbH
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2 About this document

(A Read this manual before starting
N>

V For damages due to improper connection, implementation or operation
Softing refuses any liability according to our existing guarantee obligations.

The following conventions are used throughout Softing customer documentation:

Keys, buttons, menu items, commands and  Open Start - Control Panel >
other elements involving user interaction are  Programs

set in bold font and menu sequences are

separated by an arrow

Buttons from the user interface are enclosed Press [Start] to start the application
in brackets and set to bold typeface

Coding samples, file extracts and screen MaxDlsapAddressSupported=23
output is set in Courier font type

Filenames and directories are written in italic  Device description files are located in C:
\StarterKit\delivery\software\Device
Description files

8 echocollect - Tutorial
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3 Conventions used

The following conventions are used throughout Softing customer documentation:

Keys, buttons, menu items, commands and  Open Start > Control Panel >
other elements involving user interaction are  Programs

set in bold font and menu sequences are

separated by an arrow

Buttons from the user interface are enclosed Press [Start] to start the application
in brackets and set to bold typeface

Coding samples, file extracts and screen MaxDlsapAddressSupported=23
output is set in Courier font type

Filenames and directories are written in italic  Device description files are located in C:
\StarterKit\delivery\software\Device
Description files
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4 Install the configuration software

Insert the installation CD in your CD-drive. Follow the instructions and install the following

software:

= NetCon: For the device configuration

= atvise builder: For creating visualization projects (optional).
During the installation, the atvise builder setup tries to acquire the activation

@ license online automatically. Make sure that you have direct internet
connection during the installation. Otherwise, contact Softing support to
receive the offline activation code.
10
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5 Introduction echocollect

This tutorial describes the method of configuring echo in the standard data acquisition use
case, i.e. the data is polled from the PLC by the echo and stored in the Database. This will
be demonstrated in the following example: echo is connected with PLCs through the plant
network and with a MySQL database (DB) through the office network. If a specific value in
the S7-300 PLC is changed, echo will poll selected values from the PLC and write them
into the database. Additionally, a logging functionality on a SD card (in the device) is
described as well.

Moreover, some further functionality of the echo is explained as well.

The topology of the devices is as follows:

Office
,&; Network
g
I
| L 1 "
Plant Network
PLC1 I PLC 2

"y

First, the echo must be connected in the networks and its network parameters need to be
set-up. This step must be done only at the beginning and is common for all the next steps.

To configure a specific data acquisition in the echo (assuming it is already connected in
the networks), only three steps are required:

1. Defining the source connection (PLC1 in our example)
2. Defining the destination connection (DB in our example)

3. Selecting the data that shall be transmitted and the trigger

Additionally, this tutorial will guide you through another important functions of the device as
well.

echocollect - Tutorial 11
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6 Configuration parameters overview

The following table summarizes the values for the network parameters and the
placeholders used in the tutorial. Personalize the values to your own application.

6.1 IP settings

Let’'s assume two separated networks in this example:

» The Office Network (where the database is located):

= The Production Network (where the PLC is located):

192.168.2.0/ 24
192.168.1.0/ 24

Database IP <DB_IP> 192.168.25.169
Database name (schema) <DB_name> echo_db
Database table name <DB_table> product_info

echo Eth 1 port IP <echo_IF1_IP> 192.168.2.14
echo Eth 1 port network mask <echo_IF1_NET> 255.255.255.0
echo Eth 2 port IP <echo_IF2_IP> 192.168.1.15
echo Eth 2 port network mask <echo IF2_NET> 255.255.255.0

Default gateway <echo_GTW> 192.168.2.126
DNS Server <echo DNS> 192.168.2.126
PLC1IP <PLC1_IP> 192.168.1.241

We recommend printing out this table and referring to it when reading the
following text.

12
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6.2

Network Topology

Following a topology example. Values in angle brackets are placeholders:

—

SQL Database

IP: <DB_IP>
Network: <echo IF1_NET>

‘.—_'—'—-—_
default gateway
IP: <echo_GTW>
echocollect NetMask: <echo_IF1_NET>
>

Port Eth 1:
IP: <echo_IF1_IP>
Network: <echo IF1_NET=>
Port Eth 2:
IP: <echo_IF2_IP> PLC 1
Network: <echo IF2_NET>

IP: <IP_PLC1>

Network: <echo_IF2_NET>

echocollect - Tutorial
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7 MySQL Database

71 MySQL Browser

1. Connect to your <DB_name> database using MySQL Browser or a similar tool and
log in.

2. Open the existing table <DB_table> or create a new one.

You may need to contact your network administrator to get the settings and
access rights for the database.

3.
4.

Create the table columns (time_stamp, ID, Name, etc.).

For details refer to the following figure:

———
IJ

Lo

Table Name: |I:'|'0dUEt_inf0

| Schema: echo_db

Collation: [Iah’nl - default collation

V] Engine: [Inr‘loDE

Comments:

test table for echo collect

Indexes

Foreign Keys

Triggers

Partitioning

Column Mame Datatype PK MM UQ BIN UN ZF AI Default
time_stamp VARCHAR(20) ] O e s A [
> ID VARCHAR(45) [l B B E B
> Name VARCHAR{45) OO0 @O O I O Nuw
> Length VARCHAR(45) 080 B8 B B B B N
> Width VARCHAR(45) OO0 0o 0O 8 B E N
> Pressure FLOAT OO O @O O & O Nuw
» Temperature FLOAT OO0 B B & B N
[ ] O O O
Column Name:  time_stamp Data Type: VARCHAR(20)
Collation: | Table Default Default:
Comments: Primary Key Mot Mull [ Unigue
[ Binary [ unsigned [ zeroFill

Options

[7] Auto Increment

Revert

14
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7.2 Direct SQL Query
Alternatively, you can directly use the SQL query on the database, using code such as:
CREATE TABLE ‘echo db'. 'product info™ (

‘time_stamp‘ VARCHAR (20) NOT NULL ,
"ID° VARCHAR(45) NOT NULL ,

*Name® VARCHAR (45) NULL ,

"Length® VARCHAR(45) NULL ,

‘Width® VARCHAR (45) NULL ,
"Pressure’ FLOAT NULL ,
‘Temperature” FLOAT NULL ,

PRIMARY KEY ("time stamp’) )

COMMENT = 'test table for echo collect\n';

Now, your table is ready for data acquisition.

echocollect - Tutorial
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8 Connect to the device with NetCon

8.1 Start NetCon

1. Start the configuration tool by opening the NetCon echo program.

{4 softing NetCon Configuration | = || & [[=234]

I Configuration via TCP/TP ]

[ Configuration Offline (File) ]
Englsh

2. Select your preferred language and click [Configuration via TCP/IP].

8.2 Scan for stations

1. After starting the configuration tool, the following dialog is opened and displays the
echo device(s). If the device scan has not been started automatically, click on [Scan
for stations].

g Select a station in your network via TCP/TP E
Stati dy.
N
Station Name Device Address TCP-Port
n
- (00A2DAZ230860) 982
- (00A2DA230860) 982 Help
Edit
Delete
Execute stationscan on start |:| Use Timeout Timeout 3 ]

16 echocollect - Tutorial
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2.  When the station scan is finished, select your echo device and confirm with [OK].

3.

8.3

1.
2.

o

If your device is not detected automatically, possible causes might be:

Your device is disconnected (check the front LEDs)

Your device is connected behind a router

You use a firewall that blocks ports 997 or 982 (TCP+UDP)

If you use configuration over H1, make sure that you installed the protocol driver

IP address for device setting

Assign an IP address to the new device.

Open the Station Parameters window and enter the desired name of the device and

the network parameters:

IP Address <echo_IF1_IP>
Subnet Mask <echo IF1_NET>
DNS Addresses (optionally) <echo GTW>
Router Addresses (optionally) <echo_DNS>

Alternatively, you have the possibility to use the DHCP service. It is also possible to

set the access password for the device:

Q Staticn Parameters

Station Name

Eco_214 Ok

Cancel

[

Password of the Station

[

Password Confirm on Edit Help

MAC (Ethernet) Address 00 A2 DA 2308 60

TCP/IP Station Parameter
Use DHCP

IP Address 192.168.2.14
Subnet Mask  255,255,255.0

Domain Mame

Maximum three Domain Server Addresses

DNS Addresses 192.168.2.126

Maximum three Router Addresses

132.168.2. 126

Router Addresses

7 |

4. Confirm with [OK]. Now the device has the specified IP address.

5.

If you then perform a new station scan, the device will appear in the station list under

the selected name.

echocollect - Tutorial
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9

IP settings

echo has two independent network adapters in order to separate the office and
manufacturing network.

1.

In order to set the IP addresses of the first network interface (office network), open

the main NetCon echo window.

Select Station > Own Station 1:

p

-Pd B

ﬂ Station Password

Settings  Help

COwn Station 1 Mam
COwn Station 2

[

5

Mpi Station Values

Ssh
SNMP

Set Original MAC Addresses

In the opened window you can specify the <echo_IF1_IP>, <echo_IF1_NET>,

<echo_GTW> and <echo_DNS>:

Ea Station Parameters Adapter1

Station MName Eco_214
MAC (Ethernet) Address 00 A2 DA 23 08 60
TCR/IP V4 Station Parameter
[ use DHcP
IP Address 192.168.2. 14
Subnet Mask  255,255,255.0
Domain Name

Maximum three Domain Server Addresses

DNS Addresses 192.168.2.128

Maximum three Router Addresses

Router Addresses 192.168.2.126

(-7 =]
TCP/IP V& Station Parameter
[ use Dhep [ Use Autoconf
IP Address

Subnet Size 0

Maximum three Domain Server Addresses

Maximum three Router Addresses

18
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Configure <echo_IF2_IP> and <echo_IF2_NET> as follows:

For the second network interface (production network) select from the NetCon echo
main menu Station > Own Station 2.

Ea Station Parameters Adapter 2

Station Name Eco_214

MAC (Ethernet) Address 00 A2 DA 2308 61

TCP/IP W4 Station Parameter
[7] Use DHCP
IP Address 192.168.1.15
Subnet Mask  255,255,255.0
Domain Name

Maximum three Domain Server Addreszes

DMS Addresses

Maximum three Router Addresses

Router Addresses

TCR/IP V& Station Parameter
[ Use Dhep [ use Autoconf

IP Address

Subnet Size g

Maximum three Domain Server Addresses

Maximum three Router Addresses

(2wl

QK
Cancel

Help

echocollect - Tutorial
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10

10.1

Add a database connection

New connection

1.
2.

Open the NetCon echo main window.

From the NetCon echo main menu select Connection = New Connection:

E echocollect [ECo_214] Connections

'ﬁ D Switch on/off Ctrl+A

Pic T/ ™7 Mew Connecticn Ctrl+N
- +  Edit Connection

Copy Connection

¢ Delete Connection Del

File | Connection | Diagnostics Collect  Static

[ﬁ

21

Enter the desired name of the connection and select Logic Table Collection >

Database:

Q New Connection

Connection Name DE|
Connection Type

b

n= @
!

)

[ Logic Table Connection ][ Protocol Convert ][ Other Connection
() PLC/Raw (7 Memory (©) OPC Pipe Client
@ Datsbase () File () Mail

20
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10.2 Database connect parameters

1. Now select the type of the database ("MySQL" in our example).

2. Type in the IP address of the host computer <DB_IP>, the database’s username and
password and the name of the database <DB_name>:

EZ Database Connect Parameters @
Connection Name DB
Datab: T
atabase Type Cancel
@ MysQL ) Crade ) MsSQL ") Sybase ————
Help
) DBf2
IP Settings Special DB Settings

Destination IP Address 192, 168,25, 169
Life Data Acks

Destination Part 3306
Username echouser
Password TTITTITY)
Database echo_db

10.3 Collect destination connection configuration

1. In the following window, you can specify if you want to buffer the data in case the
connection to the database is lost. If you want to use this feature, select Store
frames for resending after network failure.

2. Activate the option Keep frame sequence after network failure if you want to keep
the written entries in the database order according the timestamps.

3. Specify the desired file name for the buffer. The data is buffered in the echo RAM
memory and stored on the SD card only at specific intervals.

Keep in mind that lower values will reduce the amount of data that the SD
card can store due to frequent writing cycles.

EE Collect Destination Connection Config @
Connection Name DB [ brop first value after slave connection reestablishing
When to store frames m
) Don't store frames @ Store frames for resending after network failure ————
_) Store frames for logging \&J
Logging file settings
Keep Frame sequence after network failure
[] tmmediate write confirm File Name Example
Flename DE_buffer fCollect/DB_buffer
Max disc space used (mb) [7] create subdir Write interval 500 seconds
When to create a new file How to number files

Mever Hourly aily Weekly Monthly Sequentially With date ftime

4. Complete with [OK].

echocollect - Tutorial 21
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11 Add a PLC connection

11.1 New connection
1. Open the NetCon echo main window.
2. From the NetCon echo main menu select Connection 2 New Connection.

3. Enter the desired connection name and select Logic Table Collection > PLC/Raw

- Ethernet
EE Mew Connection @
Connection Name S57_TCP DK
Connection Type

Cancel

Help

= ([0 ?_'j.
m =

el

[ Logic Table Connection H Protocol Convert “ Other Cannection ]
@ PLC/Raw () Memory (7} OPC Pipe Client

") Database ) File ) Mail

PLC Transport Protocol

@ Ethernet ) Serial / Bus

4. Confirm with [OK].

11.2 Network protocol

1. Select the network protocols for your PLC.
2. In the example select TCP/IP and Siemens S7:

EE Network Protocol @
Connection Name  57_TCP
Transport Protocol
|
@ TCPfIP
7 H1

Application Protocol

") Send/Receive

() Siemens 55 AP

@ Siemens 57

(Z) Modbus TCP

() Rockwell CompactLogix / ControlLogix
") Rockwell Slc / PIc5
() Mitsubishi Melsec-Q
) SNMP

") DLMS

© bau

22 echocollect - Tutorial
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11.3 New logic table connection

1. Use <PLC1_IP> as Destination IP Address.

2. [f you are not sure about the advanced settings, use the default settings as shown

below:

Ea Mew Logic Table Connection
Connection Mame  57_TCP

Write allowed || OPCPipe Access allowed
TCP/IP Parameters

Destination IP Address 192,158, 1. 241
|:| Is IpWi Connection

Destination Port 102
Type Protocol
Client (Active) @) TCP (with Ack)

Spedal Settings
[ PLE Header Life Data Acks Rfc1006

| SpecalSettings || RFC1005TSAPs |

2 |
o |

Connection Active ok

OPCPine Write allowed
OPCPipe Write allowed Cancel
Help

Performance Settings
Optimizing

max. read gap 4 3 default

Gaps bigger than this setting will generate separate requests,
[ Don't combine different types
Handling details
|| pisable multiple plc area in one request
|:| Keep time sequence for write
[ 1mmediately echo written values
Timeout
Application Timeout {(sec) 20
Reconnect Error Timeout (sec) 0
0 disables the Application Timeout
Poll Time
Pollall 1000 ms

I Protocol Settings

| |57 3001400

3. You can disable the write access in the PLC by deactivating Write allowed.

4. If you need to access the PLC over OPC DCOM Tunnel (OPCPipe), activate

OPCPipe Access allowed.

5. The RFC1006 Setting is the default Siemens TCP/IP communication channel (port

102).

6. [f you need to specify TSAP details, click on the [RFC1006 TSAPs] button.

7. The Poll Time specifies how often the echo communicates with the PLC.

8. Confirm the settings with [OK].

11.4 Collect destination connection configuration

1. For communications between the PLC and the echo, frame buffering is not needed.

Therefore activate Don't store frames:

EE Collect Destination Connection Config

Connection Name S7_TCP
When to store frames

@ Don't store frames

[] Drop first value after slave connection reestablishing

~| Store frames for resending after network failure 7|
Help
) Store frames for logging

-7l

Cancel

2. Confirm with [OK].

echocollect - Tutorial
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12 Connection diagnostics
After having configured the connections, you can verify the status of each connection.
1. Todo so, open the main NetCon echo window in the connections list.
2. Select the desired connection with a left mouse click.
3. From the NetCon echo main menu select Diagnostics > Show one Connection
4. For the database connection, a window similar to the following appears:
EE Device Connection Diagnostics @
Connection Mame DB Conn: OK
X1
Metwork Side Metwork Side
Sent Frames 0 Frames Sent 0 Rec
RecFrames 0 e —
) Disconnects
Disconnects 0 Status
Status Ok Val Send (HEX) Rec {HEX)
5. For the PLC connection, a window similar to the following appears:
Ea Device Connection Diagnostics @
Connection Mame 57_TCP Canin: Ok
X1
Metwark Side Collect Side
Sent Frames 0 Frames Sent 0 Rec 0
RecFrames 0 Bytes Sent 0 Rec 1]
) Disconnects 0
Disconnects 41 Status oK
Status Ok Val Send (HEX) 0 Rec (HEX) 0
6. Inboth cases, the value for Status should display OK.
7. If the status is not ok, check the connection and the device configuration.
Possible causes for a connection problem might be
= wrong IP configuration
= wrong firewall or router setting
= wrong credentials, rights or settings for the database access
= other network connection issues
Consult your network administrator to solve these problems.
24 echocollect - Tutorial
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13 Define Collect Symbol Table

It is possible to define, import (for S7 controllers) or browse (for CLX controllers) symbolic
names for the PLC items. This is done in the Collect Symbol table.

1. Open the NetCon echo main window.

2. From the NetCon echo main menu select Collect - Collect Symbol Table.

3.  When calling up for the first time, a window is opened where you can select the

relevant connection.

4. If no connection is shown, click the [Add] button.

K4 collect Symbol Table Edit
Topic :
M1
57
[ Load ] [ Save

7| =]
Close

Help

Edit

Delete

K4 Collect New Symbol Table |- B |[wt3m)

-

New Topic  CLX|

5. Select the PLC connection (New Topic) and complete with [OK].

13.1

Add and edit symbols

1. When calling up for the first time, a window is opened automatically where you can

add a new item.

2. If no window appears, click the [Add] or the [Edit] button.

K4 collect Symbol Edit

Conenction Name 57

Symbol Name testvalue
Item db5.b2
Data Type Uniused
Array Length

Comment

7] =]

Ok

Import ]

Cancel

Help

3. Here you can manually define the symbol name and the item, using the item syntax.
Refer to the integrated help for the item syntax specification.

4. If you use Siemens S7 or Rockwell CLX controller, you can import or browse the item
definition as described below.

5. Complete with [OK].

echocollect - Tutorial
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6. The window containing the overview of all defined symbols for the specific
connections is opened:

K4 Collect Symbol Table Edit

(8|

Conenction Name 57 Close
Symbol : Item Comment
counter db5.b3

flag 65,33
testhrray DE10.REAL2.5
testvalue db5.b2

o1 ey
i db5.b4

3 db5.b5

ted db5.b6

s db5.b8

13.2 S7 symbol import

1. Alternatively, you can import the symbol definition from your S7 project using the
[Import] button in the window for adding new symbols.

2. Anew window is opened:

U 7 Symbol Import 7=
Project
Ok
57 project filename
[fsrvden MNBG/DCNEG/Qualitaet/SPS_Prog_akt/S7/S7-INAT/S7-IMAT/416_m_CR.s7p
Internal 57 project name
INAT-57 ) Refresh
FLC-Frogram PLC-Blocks
No Plc Program Typ Name’ Info o
1 INAT-S7\414_cpdd3_AdviCPU 414-2 DP\S7-Programm(l) - DB 34
12 IMAT-S7\416_CP_INAT\CPU 416-2 DP\ST7-Programmi(12) > DB 37
13 INAT-STAECHOLINKACPU 315-2 PN/DP\S7-Programm(13) > DB 44
14 INAT-571313_CP343-1\CPU 313\57-Programm(1) 4 DB 52
15 IMAT-S7\Q5-ECHONCPU 315-2 PM/DPAST-Programmi(13) DB 52, WORD0.501 STATO
DB 53
. DB 55 | The list of PLC blocks in1
DB 57
> DB 58 - Y%
4 m L3

3. Select the desired symbol for import and complete with [OK].

13.3 Import multiple symbols

You can also import multiple symbols in a single step:
1. Go back to the Collect Symbol Table Edit table window.
2. Right-click on the list and select Multiple Symbol Import:
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3. An S7 Symbol Import window appears. Here you can open the S7 project file and
select multiple symbols to import.

KA Collect Symbol Table Edit

(5| S
Conenction Name s7 Close
Symbol = Item Comment
counter db5.b3
flag bs:3.3
testArray DB10.REAL2S
testvalue db5.b2
o g
tw2 db5.b4
3 db5.b5
jatt db5.b6
jats] db5.b&
Add Symbol
Multiple Symbol Import
q I

4. Confirm with [OK].

13.4 CLX browsing

It is possible to browse online for symbols that are stored in a Rockwell CLX controller

and to add the selected symbols to the symbol table.

1.

Use the [Import] button in the window for adding new symbols to order the browsing
dialog:

Ea Collect Browsing

Element Access Parameters
PBUSL Fault  Read/Write Typ INT32, Mo 0
> PLC1_Rev_G...
> PLC1_Rev_G...
> PLC1_Rev G...
> PLC1_Rev_G...
4 PLC1 Rev G
77777, Read/Write Typ INTE, Mo 0
AckMew... Read/Write Typ Beol, Ne 0
S5tCode  Read/Write Typ INT16, No 0
77777, Read/Write Typ INTE, Mo 0
StStopped Read/Write Typ Beol, Ne 0
StStarting Read/Write Typ Bool, No 0
StStarted Read/Write Typ Bool, Ne 0
StStoppi.. Read/Write Typ Beol, Ne 0
StFault Read/Write Typ Bool, Ne 0
InWarning Read/Write Typ Bool, No 0
4| 1

»

| =

Ol
Cancel

Help

2. Select the desired symbol to import and confirm with [OK].
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14 Configure Collect Table

1. The next step is to define
o what data will be read from the PLC and stored in the DB and
o the trigger of this operation (i.e. when this action is to be performed).
2. Open the main NetCon echo window.
3. From the the NetCon echo main menu select Collect > Collect Frame Table

4. Anew Collect Frame window is opened:

H® Collect Frame [ECo_214] == =]

File Table Elements OnlineDiag Special Settings  Edit Mode  Help
TEREEVNZI DR PlESG = ©
Database

Connection:
User:
Password:
Server:

- L
List: Mew table
Function: none +Flash |

Trigger:  no trigger item

14.1 New Collect Frame Table

1. To add a new table, select from the Collect Frame window Table = Add Table.
2. A new window with possible destinations appears.

3. Enter the desired name of the frame table (S7-DB in our example) and select the
database as destination connection (DB):

EI® Collect Create Frame @
Frame Table Mame  57-DB
Frame enabled Flash write enabled
Select a connection

Connection name Connection params

DB MySQL. Collect Destination

ST_TCP Collect Destination
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4. If you want to use the SD card logger functionality (described in SD Card Logger) for
this connection, the setting Flash write enabled must be activated here.

5. Confirm with [OK].

6. The destination connection with its parameters will now be displayed in the Collect
Frame window:

HE Collect Frame [ECo_214] (modified) =R EcH )

File Table Elements OnlineDiag Special Settings  Edit Mode Help

THEEEIE VB ERAQFRES = ©

[l

Database

192.168.25. 169

Server:

7. The left cylindrical-shaped block represents the destination database. The rectangular
block in the middle defines relationships between the source (PLC) and destination

(database) items.

14.2 Add read frame entry - for time stamps

1. Now you need to select the items that will be read from the PLC and written in the
database.

2. Right-click on the £l icon in the upper right corner of the S7-DB block, and select
Add read frame entry from the context menu:

List: 57-DB Y =
Function: Database + Flash 58 | SRR R T i
Trigger:  no trigger item :E Add write frame entry
7 Add Table
", Chain Table
@ Switch on/off
1

/| Aleft-click on the icon will select the Add read frame entry command
\é/ without displaying the context menu.

29
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3. Anew window is opened allowing you to define the column where you want data to be

written to.

4. If the connection to the database is active, you can directly select the values with the

buttons. A window with lists of values is opened:

FI# Collect Browsing Databases @
Mame of Table product_info
Elernent
_
time_stamp
D
MName
Length
Width
Pressure
Temperature
4 [ b

5. Select product_info from the field Table Name. This is your database table.

6. Select time_stamp from the field Column Name. This is the column in your table

where data will be written to.

7. Select the INSERT function in order to write new records to the database.

8. In order to use the time of the echo internal real time clock as the time-stamp when
the frame was generated, select Frame Timestamp as Entry Type.

E# Collect <h2>Database</h2> Naming [-7 [zl
Database Mame
Table Mame product_info
Function [INSERT (write new record to database) ]
Column Mame time_stamp
Procedure Name
Entry Type
) Topic/Ttem  (C) Frame Counter (O Static Text
@) Frame Timestamp () Static Binary Data
Create quotes for values
9. Click [OK].
ﬂFCollect Edit Frame Entry @
Entry Type
S :
() Topic/Item () Frame Counter () Static Text
@ Frame Timestamp () Static Binary Data

Ascii, compact format “YYYYMMDDhhmmss™

Entry Enabled [7] Raw data always new

Array settings

30
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10. Now you have the possibility to define a specific format for the timestamp. Use the
button to open the Collect Edit Date Entry. We will use the default
compact ASCII format here.

Kl Collect Edit Date Entry -7 | =3
Len of Field automatic
Generation Format
_
@ Asci
_
) Utfa
) Bed

) Binary, default format

~) Binary Big Endian
() Binary Litie Endian

Display Format

) Custom Date Format
@ Compact (YYYYMMDDhhmmss)
) Iso (YYYY-MM-DD hh:mm:ss)

71 German (D0.MM.YYYY hh:mm:ss)
) Unix Timestamp

) Unix Timestamp with microseconds

Fitting
(@ Blanks Boundary
Binary zero Left @ Right

Note

Make sure the used format of the item is always compatible with the value
type of the column in the target database.

14.3 Add read frame entry - for ID

In a similar way, let’s define the next item that will be written to the database. We want to
read the value of the db5.b1 item from the S7 PLC and store it under the "ID" column in
the database.
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1.

o > 0o DN

o

Right-click on the icon in the upper right corner of the S7-DB block and select
Add read frame entry from the context menu:

I =

Help

El® Collect <h2>Database< /h2> Naming [~ 5| [mE3m]
Databaze Mame

Table Mame product_info

Function INSERT (write new record to database)

Column Mame 1D

Procedure Mame
Entry Type
@ Topic/Tterm () Frame Counter ) Static Text
) Frame Timestamp [ Static Binary Data

[] Create gquotes for values

Select ID for the Column name.
Select Topic/ltem as Entry Type allowing to read the values from the PLC.
Click [OK].

Now you need to define the source connection (Topic) and the source memory
location (ltem) you want to read from the PLC.

You can use the button for selecting the Topic and the Item.
In the pop-up window for the Topic, select the S7_TCP source.

For Item enter the desired source memory location. In our example, we will use db5.
b1.

@ Note
If you have already defined symbols in the echo symbol table (i.e. if you have

imported symbols from an S7 project, used CLX browsing or defined
symbols manually), you do not need to enter the item name and you can
use the button for selecting the desired symbol.

Set the trigger on value change. This means that the new value is updated in the
database as soon as the value of the item changes.

You can change this default trigger behavior in the Collect Table menu with

Special Settings = Trigger Settings.
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P

Normalisation

@ no Mormalisation ()

Error Handling

@ Use zero
Forward error status

E® Collect Edit Frame Entry @
Entry Type
o - -
@ Topic/Ttem () Frame Counter () Static Text
() Frame Timestamp () Static Binary Data
Asdii, Decimal
Trigger
7 no Trigger @ Trigger on value change

(") complex Trigger

automatic type conversion

) Mormalisation

) Empty value

Entry Enabled || Raw data always new

) Last valid value
() Don't send frame

Edit Trigger

Edit Mormalisation

10. The Collect Frame window should look similar to the following window:

HI Collect Frame [ECo_214]

TR EEVH VB E QRS G =

$7-DB

Database

== ][=]
(7)
o Connection: 57_TCP
eetPlcType: 57
T |address:  192.188.1.241
=
List: 5708 .=
Function: Database + Flash
Trigger: S7_TCRdb5.b1
Function: INSERT INTO
Table: product_info
Column: time_stamp
Column: jul
Timestamp: "
B

11. Save the table in the Collect Frame menu with File = Save

12. Now your table is active and the echo is ready to write to the database.

If desired, repeat the previous steps to add additional items that you want to read from the

14.4 Add additional read frame entries
PLC and write to the database.
14.5 EXxit collect table editor

To exit, select from the Collect Frame menu File > Save and Exit or press the key Esc
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15 Online Frame Table Diagnostics

The functionality of the collect table and the state of the connections can be verified using
the integrated online diagnostics.

1. Activate Online Frame Table Diagnostics.
2. Open the Collect Frame menu. Select Online Diag = Online Diagnostics.

3. The Collect Frame window looks similar to the following screenshot:

¥ Collect Frame [ECo_214] [E=E ESH 5

File Table Elements OnlineDiag Special Settings Edit Mode Help

§7-DB
" Database '1
Connection: DB Frames: Send 9149

Frames; Send 6477, Rec 0 Frames: Rec 9149

Bytes: Send 432985, Rec 0 Disconnects 0, Val 183, ErrCount 0
Disconnects 0, Val 0, ErrCount 839 List: 57-0B

Function: Database + Flash

Send 6294, Rec 0, Val 0
Function: INSERT INTO
Table: product_info

Column: time_stamp
Column: D
Timestamp:

Send 0, Rec 6611, Va) 183

A

A

The meaning of the diagnostic fields is as follows:
= Database
o Send/receive frames to/from the database
o Send/receive bytes to/from the database
o Number of access attempts when the DB was disconnected
o Last written value
o Error counter
» Frame List (for each item)
o Send/receive items to/from the PLC
o The last valid value
= Connection (source)
o Send/receive frames to/from the PLC (updated within the polling time)
o The last value read
o Failures due to Disconnected source
o Lastread value

o Error counter
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Note

In case the error counter is increasing, check the device log to find the
problem. Open the Collect Frame menu. Select Online Diag = Logger.

The diagnostic counters are reset to zero when the collect frame table is
saved.
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16 Database check

The database should now contain the data acquired from the PLC.

1.  Query the database using the following script:
SELECT * FROM echo db.product info LIMIT 10;

2. You will get the first 10 entries in the database:

SALFile2” *

BE|7Z ¥ R0800R<|Q 1=
1 e SELECT * FROM echo_db.product_info LIMIT 10;

Filter ﬂ|m|ﬁ§;§g|ﬁz_g_{s|mmﬁ|mchms%&é?“ﬁ.
time_stamp D Name Length Width Pressure Temperature

b | 2030624152307 97
20130624152317 107
20130624152327 117
20130624152337 127
20130624152347 137
20130624152357 147
20130624152407 157
20130624152417 167
20130624152427 177
20130624152437 187

= r:m

In our example only the columns time_stamp and ID were used. Therefore
the other columns are empty.
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17 SD Card Logger

The echo can store the acquired data on a removable SD card. This functionality is
especially beneficial in cases where storing into a database is not possible (e.g., no
network connection) or in mobile machinery.

SD Card Logger is an optional feature to be paid separately.

17.1 Add file connection

1. Open the NetCon echo main window.
2. From the NetCon echo main menu select Connection = New Connection

3. Enter the desired name of the connection (in our example SD) and select Logic
Table Collection > File

Ea Mew Connection @
Connection Name Mew Connection
Connection Type
=5 _J
:

»

S=0D|
e ap =

l Logic Table Connection ” Protocol Convert ” Other Connection l
) PLC/Raw () Memory () OPC Pipe Client (C) OPC Pipe Server (Cached)
() Database @ File ) Mail
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4. Confirm with [OK].

5. ACollect Destination Connection Config window is opened:

Connection Name 5D
When to store frames

Don't store frames

Logging file settings

[ Immediate write confirm

E:a Collect Destination Connection Cenfig

Keep Frame sequence after network failure

7 |l

[] Drop first value after slave connection reestablishing
Store frames for resending after network failure

@ Store frames for logging

File Mame Example

Maix disc space used (mb)
When to areate a new file
@ MNever ) Hourly
[T] File Upload
Connection
Upload Path
Delete file after upload

File Mame Example

Filename logger_file

[Collectflogger_file

[7] create Subdir Write interval 10 seconds
How to number files
) Daily 1 Weekly ) Monthly ) Sequentially @ With date ftime
add

Append to File (after append on server the local file will be deleted)

6. Enter the desired file name (in our example logger_file) and select Store frames for
logging as we want to store all frames.

7. Specify the write interval (10 seconds in our example), i.e. how frequently the data will
be written to the SD card. (Data is buffered in the RAM in-between).

Note

@ When you save to an SD card (flash drive), the number of writes is limited.

The fewer writes you record, the longer the lifetime of the flash drive will be.

8. Additionally, the File Upload option allows you to store a data file on a remote server

over the network.

9. Complete with [OK].
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17.2 Create collect frame table for logging

1. Next step is to define what data will be stored in the file on the SD card.

2. Create a new collect frame table. Open the NetCon echo main menu. Select Collect
-> Collect Frame Table

3. Then open the Collect Frame menu and select Table > Add Table

4. Let's name the frame table as "logger" and select SD as the destination connection:

I Collect Create Frame @

Frame Table Mame  logger oK

o Flash write enabled
Frame enabled ash w ab

Select a connection

Help
Connection namé Connection params
OB MySQL. Cellect Destination Add-=
ST_TCP Collect Destination
5D Flash anly
5. Click [OK].

6. Now, similarly to the database example, add a read frame entry in the frame table. To
do so, right-click on the icon in the upper right corner of the frame table list block
and select Add read frame entry from the context menu.

7. Add the timestamp as the first read frame entry:

= Collect Edit Frame Entry @
Entry Type
R -
() Topicftem () Frame Counter () Static Text
@) Frame Timestamp () Static Binary Data

HIray setangs

Ascii, compact format ™YYYMMDDhhmmss™

Entry Enabled [ | Raw data always new
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8. Click [OK].

9. Add a new read frame entry and select the topic S7_TCP.

10. Define the item with db5.b1 (in our example) that will be read from the PLC and

written to the logger file.

11. Activate Trigger on value change.

P

Normalisation

) Mormalisation

Error Handling
@ Use zero ) Empty value
Forward error status

Entry Enabled || Raw data always new

E® Collect Add Frame Entry @
Entry Type
o : :
@ Topic/Ttem () Frame Counter () Static Text
() Frame Timestamp () Static Binary Data
Asdii, Decimal
Trigger
7 no Trigger @ Trigger on value change
) complex Trigger Edit Trigger

@ no Mormalisation () automatic type conversion

Edit Mormalisation

) Last valid value
() Don't send frame

12. The corresponding collect frame table should look similar to the following screenshot:

8 Collect Frame [ECo_214]

File Table Elements OnlineDiag Special Settings  Edit Mode Help

THEECEVH B FROMAES = ©

‘H'DB Disk.
agger Connection: 5D
File: logger_file

logger
Function: Disk Data
S7_TCPR.db5.b1

[E=H e =X

Connection: S7_TCP
PlcType: 57

db5.b1

Trigger Item:

A

Address: 192.168.1,241

13. Save the collect frame table and exit the collect frame editor.

14. Your table is active now and the echo is writing the data to the file on the SD-card.
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18 FTP access

The integrated FTP server offers access to the content of the SD card over a network.
This functionality is especially useful to read the logging files.

18.1 Setup FTP access
1.  Open the NetCon echo main window.
2. From the NetCon echo main menu select Settings = Service Settings.

3. The following window is opened:

Q Device Service Settings @
Web settings
| Use Web Server ————
Cancel
Web Port 30 —
Help
Web Max Clients 10

Ftp Web User Name  web
Ftp Web Password  ses
NetSpector settings

+f| Use MetSpector
MetSpect Port 0

Memory Card Ftp Account
LUsed for MetSpector, Collect and Plc Badkup
Ftp User Name netspect

Ftp Password essessse

4. In section Memory Card FTP Account you can define your own ftp user name and
password. In our example we will use netspect for both.

5. Save with [OK].

18.2 Accessing the log file through FTP

The logged data is how available via the FTP protocol.

1. Use the <echo_IF1_IP> address with the specified user name and password. In this
example, it is: ftp:/Inetspect:netspect@192.168.2.14/

2. Access the files using Windows Explorer or any FTP client. The following files and
folders appear:

netfile.net
localtime
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3. Open the Collect folder to access the log file.

4. To access the log file directly, you can also use this format: ftp://netspect:
netspect@192.168.2.14/Collect/logger_file.dat

5. The data is stored in German *.csv format, as shown in this example:

20130624171950;188
20130624172000;198
20130624172010;208
20130624172020;218
20130624172030;228
20130624172040;238

20130624172050; 248

The German *.csv format uses semicolons (;) whereas the US English

format uses commas (,).

You can use Notepad or Excel to open the log files.
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19 OPCpipe connection

It is possible to connect the echo directly with an OPC DA client (e.g. a SCADA system)
using the "OPCpipe" DA tunnel, which is integrated in the device.

The OPCpipe client is required on the client PC. Make sure that it is properly
installed.

OPCpipe client is an optional feature to be paid separately.

19.1 Enable OPCpipe server within echo

1. Create a new OPCpipe Server connection by selecting Other Connection and
choosing OPC Pipe Server without PLC.

For the OPC Pipe Server without PLC you do not need to specify the target

PLC connection in the echo. If you prefer using the OPC Pipe Server option
for legacy reasons, make sure that you have defined the target connections

in the echo.
Ea Mew Connection @
Connection Name OPCpipeServer|
Connection Type

B=0D | r
X

e | oD

[ Logic Table Connection ” Protocol Convert ” Other Connection ]
C) Web | PLC FTP Server (O) OPC Pipe Server (@ OPC Pipe Server without PLC

2. Click [OK].
3. As OPCpipe Server is passive, you do not need to specify the IP address:
EE TCP/IP Connect Parameters @
Connection Mame OPCpipeServer
Destination IP Address | 0.0.0.0
|:| Is Ip¥& Connection
Destination Port 4444 2
Type

() Client (Active)
@ Server (Passive)

Special Settings
Life Data Acks
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4. Click [OK].

5. Choose the password (pwd in our example) for the connection and set the same
memory limit that you use in your client (1M recommended):

i

Ea OPCPipe Parameters @

Connection Mame OPCpipeServer

Password pwd

Connection Active Write allowed
Memory limit

() 100M () 10M @ 1M () 100K () 50K

6. Confirm with [OK].

7. Now the pipe is active and should be visible in the list of connections in the main
NetCon echo window.

Make sure to enable OPCpipe access in all the relevant PLC connections.
From the main NetCon echo window, right-click on the PLC connection and
select Edit Connection.

The following options must be activated:

Ea Edit Connection @
Name of the Connection 57 TCP|
Connection Active Write allowed
OPCPipe Access allowed [T] oPcripe Write allowed
Event Fetch [ OPCpipe
Paoll all 10000 ms

7

Collect Destination

<7

Optimize default{4), High Performance Protocol

19.2 Configure OPCpipe-client

The INAT OPC Server should already be running. You can check its status in the
windows tray:
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TP A
INAT ‘OPC Server Running |
| s
le

Customize...

Right-click on the icon in the tray and select Server Status = NetCon OPC to open

the configuration tool.

An Access Paths window is opened.

Here you need to create the OPCpipe client access path. Select Access Paths 2>

Connection = New Access Path.

Enter OPCpipeClient as a connection name. Select the OPCPipe option and

choose the OPCPipe Client connection:

= New Connection @
Connection Name OPCpipeClient

Connection Type

-
|
W 3 J,/
[ OPC > PLC I OPCPipe |
@ OPCPipe Client (”) OPCPipe Server

Click [OK].

selected:
g‘ TCP/IP Connect Parameters @
Connection Name OPCpipeClient
Destination IP Address 132, 168.2. 14|
|:| Is Ip¥6 Connection
Destination Port Rl

Type

@ Client (Active)
) Server (Passive)

Spedial Settings
Life Data Adks

Enter <echo_IF1_IP> and make sure that the Client (Active) connection type is
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7. Click [OK].

echo OPCpipe configuration:

s

In the next window, use the same password and memory limit as you have set in the

gl OPCPipe Parameters

Connection Mame OPCpipeClient

Password pwd

Connection Active Write allowed
Memaory limit

) 10M @ 1M () 100K 50K

[7] Use Send Adknowledge

[ |l
Ok
Cancel

Help

9. Click [OK].

10. You need to restart the OPCpipe client now. Select the Access Paths menu, then
File > Restart Server. The OPCpipe client window should now show the pipe

connection:

= INAT OPC Server [Q5_Win_7_x86] Access Paths |2

File Connection Diagnostics | Station | Settings  Symbols  Help

= - o e 5 W =

SEBE VLY T OUCTL RO D >
Type Access Pa{h Mame  Job MetProt Dest Address Parameters Parametel
Ip OPCpipeClient OPCPipe TCP/.. 192.168.2.14 Port 4444 Tep Write, In...

<

I

11. To check the connection open the Access Paths menu and select Diagnostics 2>

Show Diagnostics.

12. The read and write states should be OK. Otherwise check the connection and the

OPCpipe configuration.

g‘ INAT OPC Server [Q5_Win_7_xB6] Access Paths
File Station

EAEN=l=1 X2 Reg=:

hcoess Path: OPCpipeClient Read: OK

Connection  Diagnostics

Settings

E=8(EoR ==
Symbols Help
Ul % RO B >
Write: OK
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19.3 Testthe OPCpipe connection

You can test the OPCpipe connection with the installed "OPC Test Client" tool from the
Windows start menu:

e o e s

File Server View Help

|| =] 2]

Ready [ M 4

Select new server connection
1. Open the OPC Test Client main menu and select File > New.
2. Choose the INAT TcplpH1 OPC Server:

OPC Server Prog 10:
JINAT TeplpH1 OPC Server

Cancel |
Located Servers:
INA&T TeplpH1 OPC Server Browse |

Saftitg. OPC.EC. Configurationl
Softing OPC.57 .04
Softing. OPCT oolboxDemo_Se

Mode Marme [Optionall:

3. Confirm with [OK].
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Add a new group
1. Open the OPC Test Client main menu and select Group = Add Group...
2. Enter the group name and click [OK]:

Add Mew Group @

Group Mame: W %

|Ipdate Rate (mSec); 1000

v Active

Time Biag: |0 [ Update Rate
% Deadband. [1 v Allaw Timeout
Advize: | ICannectionPoint [Rew 2.0) ﬂ
r

Add new item
1. Open the OPC Test Client main menu and select Item - Add Item...
2. Define the PLC variable (or a symbol item in your echo) that you want to access.

3. For the Access Path use the syntax <OPCpipe client connection name>?<PLC
connection name>, in our example OPCpipeClient?S7_TCP

4. For the ltem Name use the item syntax for you PLC connection, in our example db5.
b1

5. Now select the data type (Datatype) of the item. In our case we will use VT_UI1

Refer to the echo manual (section 6) for an extended description of the item
syntax.
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6. The Add New OPC Item window should look like this:

Add Mew OPC Item FH
ltemz to be Added —Attributes
dbs.bl Access Path: i it \LI
© |OPCpipeClient?57_TCP - |
Itern Mame:

dbb.b1

I Add Item |
Active: W
Daatype: 5 R
Aray: [ [tem Properties |
D atatype: INative ;I ™ Amray Filter: | Aocess: I.-’-'-.Illtems LI

- Root (Mode: <Local>) Itermn Leaf I

You can add items using this dialog. Click on validate items if you wish to check pour
items againzt the server before adding them. Results will be displayed from this action.

7. Confirm with [OK].

8. The connection is now established and you should be able to see the current value (

Sub Value) of the item in the main window:

&f: RSI- OPC Test Client - [~INAT TeplpHl OPC Server] =N =R
# File Server Group kem Log View Window Help mmm
@ testGroup (Actual Rate: 1000) TtemlID Sub Value I Sub Quality I Sub Updates Update Rate I Run. Avg
@ db5.b1 233 Good 0 0.102239
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20 E-mail notification

The configuration of the echo e-mail notification functionality is described in this section.
As an example, the echo will be set up to send an e-mail every time the value of the DB1.
BO item in the S7-300 PLC changes.

20.1 Configure the connection to the e-mail (SMTP) server

1. Open the NetCon echo main menu and select Connection > New Connection.

2. Enter the desired connection name (Mail Notification in our example) and select
Logic Table Connection - Mail.

Ea MNew Connection @
Connection Name  Mail Notification
Connection Type

Hm= D | & IL-}- Vs
m=p| | A
P dp = =

[LogicTabIeConnecﬁon ][ Protocol Convert ” QOther Connection ]

~) PLC/Raw () Memory () OPC Pipe Client (_) OPC Pipe Server (Cached)
") Database (©) File @ Mail

3. Click [OK].

4. Enter the IP address of the user’s e-mail server (192.168.2.203 in our example), the
SMTP port number (25 is usually the default) and the sender’s e-mail address
(nomail@softing.com in our example). If authentication is required, enter the
username, password and the authentication type. Use Auto Select if you are unsure:

Ea Mail Connect Parameters

Connection Name  Mail Notification

IP Settings

O

Cancel
Destination IP Address 192, 168.2.203
Help

i

Destination Port 25

Sender Address  nomail@softing.com

[] Authentication

5. Click [OK].

6. The following window is opened:

Ea Collect Destination Connectien Cenfig @

Connection Name  Mail Motification [ brop first value after slave connection reestablishing
When to store frames
@ Don't store frames ") Store frames for resending after network failure
Help

") Store frames for logging
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10.

It is possible to save the e-mail message for delayed sending, in case that the
connection to the e-mail server is temporarily lost. If this functionality is desired,
check Store frames for resending after network failure, otherwise select Don't
store frames and confirm with [OK].

Now the e-mail connection is set up and should appear in the connection list in the
main window.

To test the connection, double-click it and the following window is opened:

Ea Edit Connection s DX

MName of the Connection Mail MNotification

Connection Active

-

Save

Cancel

l Metwork Parameters l Collect Destination

Help

l Collect Settings l no store

| Save and Online Test |

LS ")

Click Save and Online Test. If the connection settings are OK, proceed with the
[Save] button. If errors show up, verify the server settings and authentication in the
Network Parameters.

20.2 Define the e-mails in the recipient address book

1.
2.
3.

Open the NetCon echo man window.
From the NetCon echo main menu select Collect = Collect Mail Address Book.

In the window, click the [Add->] button to open the dialog for adding a new e-mail
recipient. This window is opened automatically, if no e-mail recipient is defined yet.

Enter the name and the e-mail address of the recipient, and add a short note
(optional). Save the entries by clicking [OK].

When all the recipients are defined, close the collect address book by clicking [OK].

K4 Collect Add Address Book Entry | 7 |[s23s] | | (4] Collect Address Book 7 )=
MName Test Recipient T RNE_H?E @Ad:tr.ess ol
est Recipient test@softing.co...
Address  test@softing.com
: Hel
et
Add->
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20.3 Add the e-mail connection as the destination in the collect
frame

1.

4.

Open the collect frame editor. To do so, open the NetCon echo main menu, then
select Collect > Collect Frame Table.

Add a new frame table. Open the Collect Frame menu and select Table - Add
Table.

Enter the desired table name (Email Notification in our example) and select the e-
mail destination connection:

Frame Table Name  Email Notification

Frame enabled Flash write enabled
Select a connection

Connection nam¢ Connection params

DE MySQL. Collect Destination

Mail Motification Collect Destination
S7_TCP Collect Destination
SD Flash only

H® Collect Create Frame @

A new frame table will be generated:

ﬂg Collect Frame [ECo_211] (modified)

FTEREEYSFIVVEEAQFEE S = ©
sD 211 [l
SQL_201

Mail
Connection: E-Mail Motification
User:
Password: =
Server: 192.168,2.203
Mail Destination: empty

List: E-mail Motificati
Function: Mail send
Trigger:  no trigger item

=]

Now assign the data that should be sent in the body of the email. Right-click the Ja=
icon of the "E-mail Notification" block and select the Add read frame entry from the
context menu.

A Collect Add Frame Entry window is opened, similar to the database example.
Here we will use the following settings:

Section Entry Type: Topic/ltem

Section Topic: Click the [>>] button and select the desired connection. In this tutorial
we will use the S7_TCP.

52
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7. Confirm with [OK].

Section ltem: the desired item from the PLC (db1.b0 in our example).

Section Trigger: Trigger on value change

8. Leave all other settings on default:

MNormalisation

| Normalisation

Error Handling

@ Use zero ) Empty value

Eorward err

Entry Enabled || Raw data always new

[ Collect Add Frame Entry @

Entry Type

@ Topic/Ttem ) Frame Counter i) Static Text

) Frame Timestamp () Static Binary Data

Asdi, Dedmal

Trigger

) no Trigger @ Trigger on value change

) complex Trigger Edit Trigger

@ no Mormalisation () automatic type conversion

) Last valid value
) Don't send frame

9. Confirm with [OK].

20.4 Assign the desired recipient from the recipient address book

1. To specify the e-mail target open the Collect Frame menu and select Special

Settings > Mail Target

2. Inthe Select Address window activate Use Mail Targets, enter the desired mail
subject (or leave the field empty for the frame name as subject) and choose the
desired recipient from the address book:

E® Select Address
Use Mail Targets

Mail Subject test email

Select recipient address

Leave empty to use the frame name a= subject.

(e ===

Cancel

Help

-~

MName Address  Comment

Softing Info _ info@5...
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3. Click [OK].

4. The collect frame window will look like this:

F1# Collect Frame [Eco_214]

File Table Elements Online Diag Special Settings  Edit Mode Help

THRCEVHE VB IRQFEEG = ©

Email Motification
57-DB
logger

===
-

Mail
Connettion: Mail Notification

User: gs-
Password: =
Server: 192.168.2.203

Mail Destination:  Softing Irifa.

Function:
Trigger:

Trigger Ttem:

Email Notificati
Mail send
57_TCRdb1.bd

Connection: S7_TCP
Pl Type:

db1.b0

M

7
Address: 192.168.1.241

5. Save the collect frame table.

7. Close the Collect Frame window.

6. You can use the online diagnosis in order to verify the connections.
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21

21.1

Enabling OPC-UA Server

In order to set-up the integrated OPC Unified Architecture (UA) server, you need to add
an OPC UA Server connection.

The integrated OPC-UA Server will provide then the items that are defined in the symbol
table.

OPC-UA is an optional feature to be paid separately.

New connection

1. Open the NetCon echo main window. From the NetCon echo main menu select
Connection - New Connection.

2. Inthe opened window select Other Connection - OPC UA Server.

-
EE Mew Connection [

? 22|
MName of the Connection ua
Connection Type
B=0D | | = Hy
+ ¥ - ~
[ Logic Table Connection ] [ Protocol Convert l [ Other Connection ]
) Web PLC FTP Server () OPC Pipe Server (C) OPC Pipe Server without PLC

@ OPC UA Server

3. Click [OK].
4. Enter the desired name of the connection (in our example UA) and the destination
port (default 4840).
EE TCP/IP Connect Parameters @

Ok
Mame of the Connection ua

Cancel

Destination Part 4340 Help

5. Confirm with [OK].
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21.2 Server Endpoint

1. Define the Server Endpoint. By default, the Server Endpoint consists of the IP

address of the echo device and the OPC UA server destination port.

2. Write down the server endpoint for the configuration of the OPC UA client.

K#] oPC UA Server Settings

Server Identity
Acceptable formats for Sever Endpoint are: opc. top/f <HostMName =: <Port> or opc. top:/f <Ip Address: <Port,
Server Endpoint: opc. tep: 152,168, 2, 14: 4840

Server MameSpace: | echocollect_items

7]

Ol
Cancel

Help

3. Confirm with [OK]. The OPC UA server in the echo can now be used.

21.3 Testwith an OPC UA Client

1. Optionally, you can test the OPC UA Server with any OPC UA client.

2. Create a new connection in the client. Use the Endpoint definition from above and

select anonymous authentication:

Server Information

Endpoint Url opc. top: /192, 168. 2, 14:4840

Security Settings

Security Policy [None = ]

Message Security Mode [None d ]

Authentication Settings

@  Anonymous
Username

Password Store

Certificate

Private Key
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3. When you connect, you will be able to access the symbols, as defined in the collect
symbol table:

_ﬁ Root

4 [ Objects
r D M
4 3w

[

(N ERRRNNDN

b 2 Types
b3 Views

[+
[ & Server

57.counter
57.flag

57 testArray
57 testvalue
5740l
5742
57403
57.tvd
5705
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22 Configuration backup

There are two ways to back up your configuration of the echo:

1. Store configuration on the SD card

and

2. Store configuration on a PC

221 Store configuration on the SD card

1.  Open the NetCon echo main window.

2. From the NetCon echo main menu select Settings - Parameter in Flash.
3. Confirm the message with [OK]. The parameters will be stored on your SD card.
4

When the echo is restarted and any saved configuration is present on the inserted
SD card, this configuration will be automatically loaded and the configuration on the
device will be overwritten.

22.2 Store configuration on a PC

1.  Open the NetCon echo main window.

2. From the NetCon echo main menu select File > Store Device Data in File.

3. Now you need to name the file and choose the location where it should be saved.
4

To restore the saved configuration open the NetCon echo main menu and select File
- Load File in Device.
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23 Design HMI with atvise builder

This chapter describes the design of the customized HMI and how to store it in the echo
device.
23.1 Make sure the atvise server is running

The atvise server is running locally on the PC and is necessary to create or modify the
visualization projects and distribute them in the echo devices. Be aware that it is
necessary to keep the server project files in order to perform any later changes. It is not
possible to re-create a project from the data in the echo device.

The atvise server starts automatically during Windows startup and the atvise icon
appears green:

= L) ]

If the application is not started, open the Windows start menu to start the atvise project
console. Then start the atvise server with the start button:

Server

If the start problem remains, refer to the integrated help for troubleshooting.

We recommend changing the destination of your project files. To do so,
1. stop the current project,

2. then right click the atvise server icon and select Project Console >
Settings > Add Project.

In case the server was not activated properly during the installation process, please
contact the Softing support.

23.2 Open the atvise builder
1. Open atvise builder with Windows Start - Atvise - Tools - Atvise Builder.

2. Alternatively, you can also start the atvise builder from the atvise project console.

23.3 Connect to the atvise server

1. Connect to the local atvise server with Builder > Connect to server.

2. Use the pre-defined address opc.tcp://localhost:4840
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23.4 Add new atvise server
1. Right click on the item Servers in the Project tree and select Add Server > Atvise.

Project | Welcome [E] I_

i! + Add Server.. » webMI

# M'l-ll'-‘\-llurulll

» [ Global Parameters

g Display Pool

- Ul Library

- i Object Types
& Variable Types

- ) Languages
g ':'J Users & Groups

» Q Yiews

2. In the following dialog under the group General type the desired server name.

3. For Hostname use the host name or the IP address of the echo device. This will be
referenced as <echo_IP_address> in the table below.

4. Select Softing Graph Web Server from the Type: list:

Y] Add webMI Server g =
General
MName: echoGraph
Hostname:  192,168.2.14
General Type: Softing Graph Web Server ) @

Description: Softing Graph Web Server

-/
")

Advanced

5. If you defined another user name and password for the echo FTP server in your echo
device, change the settings in the group "Advanced". In this specific case, use the
following syntax:

Url: http://<echo_IP_address>
Config Source: http://<echo_IP_address>/variables.xml
Config Target: ftp://<user_name>:

<user_password>@<Echo_IP_address>/config

Data Root Target: ftp://<user_name>:
<user_password>@<Echo_IP_address>/wwwroot
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23.5 Import symbols

In order to import symbols from the echo symbol table (directly from the device), right-
click on the server name (here echograph) and select Acquire Datapoints. The items
from the echo device will be imported and you will be informed about the result through a

dialog. The ltems will be imported under the node "OBJECTS".

23.6 Add a new display
1. Select folder DISPLAYS.

2. Thenright-click MAIN and select Add Display... from the context menu:

lit] atvise builder
builder Guided Actions

l Project

Profiles  View Help

Welcome [

4 lil Servers (opc.tcpy//localhost:4840)

#) DemoServer
4 ) echoGraph
4 I DISPLAYS

i

4 B MAIN
I USER
B SYSTEM
I REPORT
[ Default
f_ Main
B CBJECTS
[ Global Parameters
» TI7 Display Pool
L Library
W Object Types
@ Variable Types
@ Languages
] :""_ Users & Groups

Ct Views

I Add Folder...
[@y Add Display...
g Add Reference

ﬁ Find child displays...
E Find parent displays...
" Edit Display Order...
[ Import from Folder...

‘ﬂ Export to Folder...

“, Copy Ctirl+C
= [elete Display Del
D Node Actions
E Refresh

3. Adialog is opened. Enter the desired display name (display1 in our example).
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23.7 Add a new visual object

1. Add the desired objects onto your display-page. These objects could be either

custom defined (refer to the atvise help for detailed information) or you can use the
default library of the standard objects.

2. The following example shows how to add a standard gauge that shows the real time
value of an item from a PLC.

PJHluth‘Hniulnmi|u|||||m|iuiuJw”“.||||Iw“.iiu.l'mu|||||||iIWuiuJlmnu||||i|Miiu|.uilm-uinl1l:|W|

q4

X: 164.711 |5 131.452 W 100 o oo [ stk

Library

- i W PROJECT Q

g W LAYOUTS -

5 4 I ATVISE

& W Chrome fc?:h:ul,’_ul fram a dropdowr uge vahse of an address as
I Default =1 o h

ks W Glossy

=4 I LAYOUTS
. Saneiond o O InfOQut Date Tume

3. Drag the Gauge symbol from the frame library onto the main editor canvas.

4. Modify the position and size of the object by using the small violet rectangles around
the object.
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23.8 Modify the object parameters

1. Select the Gauge object with a link-click. On the right side of the editor, an Attributes
frame is opened. All the object parameters and the link to the data in the echo device
are defined here:

Attributes
Property Value
4 Parameters
base echoGraph/57. counter
label T{Test Counter}
minirmum 0
maximum 255
> Font
- Appearance
» Opticns
- SVG

2. The meaning of the Parameter attribute fields is as follows:

base The variable to display in the form of the echo item syntax.

label The text label of the object

minimum Desired minimum value of the item (e.g. 0 for a unsigned byte
variable)

maximum | Desired minimum value of the item (e.g. 255 for a unsigned byte
variable)

If you added your desired items into the echo symbol table, you do not need to
manually write the item syntax for each variable. When you click on the base value
input field and click on the [‘..."] button, a new window of the imported symbols is
opened where you can select your items directly:

echocollect - Tutorial 63



Chapter 23 - Design HMI with atvise builder

softing

o

Y Object Selector @

L Ohjects || ObjectTypes

)

> 3y Objects on DemoServer

4 [Mlr Objects on echoGraph
o loggerlogger

o mod.modl

> sf-1.57 _test 1
i 57.counter

» 57 flag

» 57 testvalue
» SLC-TestInteger-test

[ Ok J [ Cancel

)

If you want to change the appearance of the object, refer to the atvise builder help for

details.

23.9 Upload your project into the echo device

1. Save your project.

2. Then right-click on the server name and select Distribute:

Project

o !E Servers (opc.top/flocalhost:4840)
> (@) DemoServer

| | g' P et

4 @ & Acquire Datapoints
4 & Distribute
. (% Reload External Files

> (¥ Edit Server...

’ E Find nodes used in displays...

E Find unused nodes...
4 | 5 Rermove Server
’ o Mode Actions
*

. N Refresh

> 57.counter
> 57.flag

» 57 testwalue
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3.

A window with a progress bar appears. The visualization will be generated and
uploaded directly into your echo device. Make sure that you define the project files
properly in the server definition as described below.

To add more objects in your visualization, simply add them from the library and define
their attributes accordingly.

Additional examples are described in the atvise builder help. If you follow these, keep in
mind that you always need to use the item syntax or use the acquired datapoints (items)
from your echo device.

23.10 Use your visualization

1.
2.

@

o o

Open your web browser.

Enter http://[<Echo_IP_address> in your address bar (URL). The main web page of
your visualization is opened:

CMIEE & hesp /192368204 £ = & | B svise - nest genesation

- Ey B T

L

Now select the display by hovering the mouse over the display folder symbol.

Click on the desired display (display1 in our example):

i'-r;rﬂr R O

Your visualization will be displayed.

In order to create more complex projects, refer to the tutorials in the integrated help of
the atvise builder.
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